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MAYA Maya - Primi Passi Tutorial n. 3

Prepariamoci per la lezione

La modellazione NURBS ¢ particolarmente indicata per la modellazione
organica come ad esempio animali ed essere umani, nonché per la
modellazione in generale, per esempio frutti e automobili.

Particolarita della modellazione NURBS sono i vertici di controllo che
consentono di modificare la forma della nostra curva e di conseguenza della
nostra geometria.

Una caratteristica della modellazione NURBS & che le facce sono tutte
composto da 4 vertici.

In questo tutorial vedremo :

Come creare una superficie partendo da una curva

Scolpire una superficie
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Per assicurarci che le lezioni possano essere seguite, effettuiamo queste
operazioni :

1
Creare sempre una nuova scena, prima di cominciare ogni lezione.
2
Assicurarsi che il Construction History sia attivo: . (nel caso fosse
disattivo avrebbe una grossa X sopra)
3
Selezionare Modelling dal menu relativo.
4

Selezionare Window > Settings/Preferences > Preferences.

Dalla category list sulla destra, cliccare Undo e impostare Queue Size a
50; in questo modo abbiamo la possibilita di annullare le ultime 50
operazioni effettuate (Edit > Undo.).

Cliccare su Save.
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Ruotare una curva per creare una superficie
In questo tutorial, vedremo una semplice tecnica di modellazione
NURBS; tramite questa tecnica realizzeremo il portauovo
mostrato in figura.

Creare e ruotare il profilo di una curva

Una tecnica comune di modellazione & quella di creare, tramite
una curva, il profilo di una forma e utilizzare lo strumento Revolve per ottenere
la superficie finale.

1
Selezionare Panels > Layouts > Four Panes per avere una visuale
multipla della scena.

Selezionare lo strumento Create > CV Curve.
Questo € lo strumento pit comune per disegnare le curve.

Nella visuale frontale, creare una curva

seguendo l'ordine indicato in figura.

Siate certi che il primo e l'ultimo vertice siano

nella griglia dell'asse -Y. |
Inoltre, cliccate tre volte nella stesso punto per -

i vertici 9, 10 e 11. Questo passaggio serve _
per creare un angolo nella curva. | FEEEL
Per spostare la posizione dei vertici, basta

trascinarli dopo averci cliccato sopra con il

tasto centrale del mouse.

Dopo il vertice numero 13, premere invio per
completare la creazione della curva.

I punti creati non sono altro che i vertici di
controllo della curva (CVs). I CVs sono punti
manipolabili per modificare la forma di una
curva. Origin

Ovviamente la pratica € la migliore maestra,

quindi con il passare del tempo imparerete a disegnare le curve in
maniera precisa!

Ricordate solo che per creare una curva tramite lo strumento CV Curve,
Sono necessari come minimo quattro punti.
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Inoltre sappiate che l'inizio della curva e dato dal primo CV che avete
creato ed ¢ indicato da un piccolo box;la direzione della curva, invece, &
indicata nel secondo CV da un piccola icona a format di u.

6
Selezionando Surfaces > Revolve, verra creato il portauovo.
Esaminiamo il risultato dalla visuale perspective;Maya non ha eliminato la
curva del profilo!

7
Con la superficie selezionata, nominiamola Eggholder.

8
Con il puntatore del mouse nella visuale perspective, premere 5
(corrisponde a Shading > Smooth Shade All).

9

Premere quindi 3 (Display > NURBS Smoothness > Fine). In questo
modo la visuale perspective mostrera la superficie in modo molto simile a
quello che sara il risultato finale nel nostro render.
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Editare una curva ruotata

Dopo aver creato una superficie da una curva ruotata, & possibile
modificare la curva e di conseguenza la superficie, grazie al fatto
che abbiamo attivato il Maya's Construction History.

1
Selezionate la curva che abbiamo ruotato, curvel, nell'Outliner.
La curva viene evidenziata.

2
Dalla vista frontale, cliccate con il tasto destro esattamente sulla curva e
selezionate Control Vertex dal marking menu.

3
Selezionate e muovete uno o piu CVs in modo da sistemare la forma
della curva come piu desiderate. Verra modificata anche la forma del
portauovo, appunto perche il CVs & collegato alla curva dal proprio
construction history.

4

Salvate pure la scena.
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Considerazioni

Questa tecnica € il modo piu semplice per creare superfici tipo vasi, bicchieri e
cosi via!

Non & possibile fare il render di una curva, quindi vengono esclusivamente
utilizzate per creare ed editare superfici.

Oltre a muovere un CVs di una curva per alterarne la forma, abbiamo anche la
possibilita di tagliare, aggiungere, allungare, chiudere e ammorbidire una
curva!
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Scolpire una superficie

Creeremo una testa partendo da una sfera NURBS e la scolpiremo usando lo
strumento Sculpt Surfaces.
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Creare una sfera per poterla scolpire

Considerata la forma di una testa, possiamo utilizzare una primitiva di tipo
sfera per crearne una.

1
Selezionare Create > NURBS Primitives > Sphere O.
Dalla finestra delle opzioni, Edit > Reset Settings, inserire i seguenti
valori, quindi cliccare su Create:
Radius: 6
Number of Sections: 30
Number of Spans: 30
Radius determina la dimensione della sfera, in base all'unita relativa alla
griglia. Un valore di 6 e sufficiente per creare una sfera proporzionata
alla griglia.
Il numero di Sections indica il numero delle curve verticali, chiamate
isoparms.
Piu isoparms ha una superficie, maggiore sara il numero di CVs, il che
significa una maggiore precisione in fase di editing della superficie stessa.
Number of Spans determina il numero di isoparms orizzontali.
E' fondamentale riuscire a modellare usando una maglia poligonale poco
complessa, in modo da favorire un editing piu semplice e un miglior
controllo sulla superficie; inoltre in questo modo migliorano anche le
prestazioni di Maya in termini di velocita.

Note

Se selezionate Display > NURBS Smoothness > Fine o Medium nella
modalita wireframe, compariranno piu isoparms rispetto a quelli indicate
in spans e sections. La superficie viene visualizzata con una precisione
extra; considerate, pero, che le isoparms extra non hanno CVs e quindi
non possono essere editate.

Chiamate la sfera Egghead.
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3
Ruotate la sfera in modo che I'attributo Rotate Z diventi 90. In questo
modo abbiamo posizionato la forma in maniera ottimale per modellare
una semplice testa.

4

Per dare a Egghead una forma ovale, incrementate ScaleX a 1.3. Se
volete muovete Egghead sopra la griglia, in modo che non ci siano
problemi legati alla visualizzazione.
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Aumentare la lucidita per una modellazione piu semplice

Per visualizzare in modo piu chiaro gli effetti delle nostre modifiche sulla sfera,
puo essere utile rendere la nostra sfera piu lucida. La parte relativa
all'assegnazione delle superfici non € prevista in questo tutorial, quindi
limitatevi a seguire i passi indicati.

1
Con Egghead selezionato, premere 3 in modo da visualizzarlo con un
livello smoothness Fine. Premere 5 per visualizzare la superficie con la
forma smooth.

2
Cliccare con il tasto destro su Egghead e selezionate Materials > Assign
New Material > Blinn.

3

Spostate I'attributo Color di 3/4 verso destra, Eccentricity a 0, quindi
chiudete la finestra.
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Scolpiamo con le tecniche di base

Adesso vedremo le prime tecniche disponibili con lo strumento Sculpt Surfaces
Tool. Con questo strumento tireremo il mouse per spingere (push), tirare (pull)
o ammorbidire (Smooth) la forma della superficie senza selezionare i CVs.

1
Con Egghead selezionato, selezionare Edit NURBS > Sculpt Surfaces
Tool O. Nella finestra di settaggio dello strumento, cliccate sullo
strumento Reset e assicuratevi che il tabulatore Sculpt venga
visualizzato.
Nella sezione Operation, ci sono quattro operazioni per scolpire la
superfici; ognuna influenza la zona dove state operando con il mouse:
Operation Effect
Push Comprime la superficie
Pull Deforma la superficie
Smooth Diminuisce le rughe (bumps) o gli angoli
Erase Elimina gli effetti delle tre precedenti operazioni.

2
Provate a testare le quattro operazioni sulla superficie in modo da
prendere familiarita con questo strumento.
Per default, Push e Pull deformano la superficie in modo perpendicolare;
per ottenere una deformazione pil accurata, usate Push e Pull nella vista
frontale, side o top, controllando il risultato nella vista perspective.
Nel momento in cui posizionate il puntatore del mouse sopra la
superficie, il puntatore stesso prende la forma di un’icona rossa che
indica, con un'abbreviazione, I'operazione che state per compiere.
Ad esempio, Ps significa Push.
L'icona rossa indica anche il raggio della zona influenzata dalla
deformazione; il valore di Radius(U) modifica il raggio.

3
Selezionare |'operazione Erase e cliccare Flood. In questo modo verranno
annullate tutte le modifiche.

4

Selezionare |'operazione Pull e inserire Radius(U) con il valore di 0.25,
quindi tirate un paio di isoparms orizzontali senza farli incrociare.
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Questa operazione non avra effetto alcuno, in quanto il raggio d'azione
non ha alcun contatto con i CVs per entrambi gli isoparm. In base
all'operazione che effettuate, solo CVs subira l'influenza delle modifiche.

Cambiate Radius(U) a 2 e ripetete I'operazione precedente.
In questo caso la superficie viene alterata appunto perché il raggio
interseca i CVs.

Tramite I'operazione Erase-Flood, annulliamo le modifiche come visto in
precedenza.

Selezionare |'operazione Pull con un Radius(U) di 0.5. Tirate lungo una
isoparm verticale. Provate anche a tirare lungo una isoparm orizzontale.
La modifica in verticale crea una sorta di ruga (a differenza della modifica
in orizzontale), dovuta ad una superiore intensita delle isoparms verticali.

Applicate nuovamente Erase-Flood.
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Ruotate la camera in modo che I'asse X di View Axis punti verso di voi.
Tracciate nuovamente un Pull verticale.

E' molto difficile, se non impossibile, modificare simmetricamente una
superficie in una zona dove ci sono molte isoparms che convergono verso
un singolo punto, chiamato pole. Considerate sempre la posizione delle
isoparms quando decidete di scolpire una superficie. In generale, scolpite
dove le isoparms sono distribuite in maniera regolare.

10
Cancellate ancora tutte le modifiche, quindi riposizionate la visuale della
camera all'asse Z in modo che la View Axis punti dritto a voi.

Tip

Se lo strumento Sculpt Surfaces e selezionato, ma non la superficie su
cui volete lavorare, cliccate con il tasto destro sulla superficie e quindi
selezionate Select dal marking menu.
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Scolpire una superficie

Tecniche aggiuntive

Adesso che abbiamo una minima conoscenza dell'argomento, vedremo
alcune nuove tecniche prima di cominciare la caratterizzazione del viso.

1
Nella finestra Settings dello strumento Sculpt Surfaces, inserire 2 per
Max Displacement.
Tracciare un Pull stroke verticale, quindi modificare il Max Displacement a
1 e tracciare un altro stroke verticale.
Il Max Displacement stabilisce la distanza massima verso cui i CVs sono
tirati (pulled) o spinti (pushed) tramite un singolo stroke.

2

Cancellate le modifiche per la superficie.
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Inserire 2 per Max Displacement. Tracciare un Pull stroke verticale,
quindi cambiate Opacity dal valore di default di 1 a 0.2 e tracciate un
altro stroke verticale.

Una linea € piu evidente dell'altra; infatti il valore di Opacity scala
I'influenza di Max Displacement.

Facciamo un esempio: con un Opacity di 0.2, ogni stroke € aumentato in
‘durezza’ di 0.2 volte rispetto agli effetti del settaggio di Max
Displacement.

In generale e consigliato I'utilizzo di un livello basso di Opacity nel
momento in cui andiamo a eseguire un Push o un Pull. Diventa quindi
possibile aumentare la deformazione in maniera graduale con strokes
multipli.

Nel caso si volesse influenzare solo una parte della superficie, utilizzate il
mouse per creare l'area d'influenza dello stroke da effettuare.

Se Radius(U) e Opacity del brush sono piccoli, potrebbe essere
necessario cliccare la piu vicina intersezione di punti di due isoparm.

Con Opacity a 1, cancellate tutte le modifiche della superficie.
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Creare un naso

Cominciamo dal naso.

1
Posizioniamo la visuale perspective in modo che l'asse Z di View Axis
punti dritto verso di noi.

2
Resettate lo strumento Sculpt Surfaces.

3
Selezionate I'operazione Pull e impostate le seguenti opzioni :
Radius(U): 1
Opacity: 0.2

4
Selezione il settaggio Shape in modo che lo stroke risulti morbido :

5
Nella parte centrale di Egghead, tracciate uno stroke in verticale
dall'inizio del naso fino alla punta, approssimativamente la distanza fra
due isoparms orizzontali. Usate una serie di strokes per creare la
struttura del naso. Create le narici con una serie di strokes orizzontali alla
destra della punta del naso, quindi alla sinistra della punta.
Per lavorare su una zona in particolare, posizionate la stroke icon in quel
punto e quindi cliccate con il mouse e tracciate. Controllate la visuale per
verificare le modifiche in corso.
Se gli strokes creano una superficie irregolare, attivate Smooth e cliccate
su Flood una o due volte per ammorbidire tutti gli strokes sulla
superficie.
Considerato che Opacity € 0.2, Smooth risultera sottile.
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Create la cavita orbitale

1
Selezionare |'operazione Push.

2
Lasciate gli altri settaggi uguali a quelli del naso.

3
Per fare una copia di cavita orbitali identiche, visualizzate Stroke dalla
finestra dello strumento Tool Settings e attivate Reflection. Posizionate
I'icona sculpt sopra Egghead; un paio di icone Push compaiono su
Egghead.

4

Sistemate la posizione come meglio credete, quindi cliccate con il mouse
diverse volte nella posizione scelta.
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Creare l'arcata sopraccigliare

1
Selezionate 'operazione Pull. Utilizzate i medesimi settaggi relativi alla
cavita orbitale, compreso Reflection.

Posizionate I'icona sculpt sono gli occhi e tracciate strokes orizzontali.
Se necessario, applicate Smooth all'arcata appena creata.
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Creare una bocca

Con 30 Sections e 30 Spans utilizzate per creare la sfera di queste lezioni, lo
spazio fra le isoparms nella zona della bocca rende impossibile la creazione
della forma delle labbra.

Per risolvere questo problema, diventa necessario inserire isoparms nella zona
della bocca.

1
Cliccare con il tasto destro su Egghead e selezionare Isoparm dal
marking menu.

2
Selezionare Select Tool.

3
Cliccare l'isoparm orizzontale sotto al naso e, tenendo premuto shift,
cliccate anche su quella sotto.

4

Selezionare Edit NURBS > Insert Isoparms O.

Dalla finestra delle opzioni, attivate Between Selections, inserite un
valore di 2 per # Isoparms to Insert, quindi cliccate su Insert.

In questo modo vengono inserite due isoparms fra ogni paio di isoparms
selezionate, per un totale di quattro extra isoparms. In questo modo
abbiamo CVs a sufficienza per creare la bocca.
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5

Selezionate lo strumento Sculpt Surfaces.

Selezionate I'operazione Push, inserite 0.2 per Radius(U) e in Stroke
assicuratevi che Reflection sia attivato.

Cominciamo dal centro della zona fra le due labbra, quindi applicate uno
stroke esterno dal centro. E' meglio cominciare lo stroke con le due icone
una sopra l'altra (in altre parole, viene visualizzata solo un'icona).

Selezionate I'operazione Pull e settate Radius(U) a 0.3. Come per lo step
visto in precedenza, applicate stroke per il labbro superiore e ripetete
anche per il labbro inferiore.

Conviene applicare push o pull per le labbra con Ref, e Vector settato
all'asse Z. In questo modo applicherete lo stroke nella direzione dell'asse
Z (a differenza del default che & perpendicolare rispetto alla superficie)
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Scolpire una superficie

Creare altre caratteristiche della faccia

In maniera opzionale & anche possibile aggiungere ulteriori dettagli alla nostra
faccia. Provate a valutare questi consigli :

Per altre parti della faccia, il mento, le guance e la fronte, utilizzate un
Radius(U) piu largo di 1 e cominciate con un Maximum Displacement fra
0.5el.

Inserite le isoparms dove lo ritenete maggiormente opportuno, sempre
utilizzando lo strumento Sculpt Surfaces.

Per creare gli occhi, usate la primitiva sfera e scalatela come necessario
per farla combaciare con la cavita orbitale.

Per duplicare I'occhio, utilizzate Edit > Duplicate O con Scale settato a
-1, -1, -1.

In questo modo un nuovo occhio verra duplicato in maniera speculare.
Dopo aver posizionato gli occhi, imparentateli con Egghead.

Per creare un orecchio, partite da una sfera (usando inizialmente create,
quindi scale e squash).
Duplicate e imparentate I'orecchio cosi come spiegato per I'occhio.
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Reseconto del tutorial
Le primitive

La sfera NURBS che abbiamo scolpito in questo tutorial € una primitiva Maya,
una forma geometrica gia disponibile. Altre primitive comprendono cubi,
cilindri, cerchi e piani

oy - \,
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Dopo aver creato una primitiva, solitamente viene scolpita, scalata, e
comunque modificata per ottenere una forma complessa.
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Lo strumento Sculpt Surfaces

Lo strumento Sculpt Surfaces € indispensabile per una modellazione veloce
delle superfici. Prima di cominciare un progetto, fate attenzione alla posizione e
alla densita delle isoparms; sarebbe meglio fare uno schizzo su carta,
tracciando le curve per capire la forma ideale delle relative isoparms.

In generale una sfera viene utilizzata per ottenere una testa molto semplice,
ma non ¢ l'ideale se ad esempio volessimo fare un'animazione con un
espressione facciale.

Molti artisti cominciano da un cilindro o una superficie lofted.

Tradotto e testato da Fabio Cavallo — e-mail : f_cavallo@virgilio.it @



MAYA Maya — Modellazione NURBS Tutorial n. 3

Un'altra utile tecnica di modellazione :

Se avete salvato la scena Eggholder, potete importare il modello
nella presente scena Egghead, quindi posizionare Egghead dentro
Eggholder. Per importare il portauovo, basta cliccare su

File > Import e selezionare il nome della scena che contiene
Eggholder.(il portauovo, appunto)

Importando una scena, vengono importati tutti gli oggetti della
scena stessa.
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